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MS-EXCEL 
 
 
 

Definition: MS-Excel application is used to calculation, analyze information and manage lists in 
spreadsheets or Web pages. Extension of MS-Excel is *.exc. 
 
Some other definitions:  
 
Workbook: Workbook is an excel file where the user stores his data. Each workbook consists of 
several worksheet, we can say workbook is a file folder and worksheet as every page in the file 
folder. Hence, a workbook is said to be a set of worksheets grouped together. 
 
Worksheet: Worksheet is a grid of 65536 rows and 256 columns. Rows are labeled as 1 to 65536 
and Columns are labeled as A to IV. 
 
Cell: Cell is a intersection of a row and column. There are approximately four million cells in a one 
worksheet. Each cell can be store 255/1024 characters in a formula. Each cell is surrounded by light 
gray lines known as gridlines. 
 
 Range: Range is a rectangular group of cells, the smallest range is a single cell and the largest range 
is all cells in the worksheet. 
 
Addressing methods: 
There are two types of addressing. They are as follows: 
 

1. Relative Addressing: The ability to adjust a formula from one location to another is called as 
relative addressing. 

 Ex: If the formula is copied from C to D column then the formula =C10+C11 will become 
=D10+D11. This adjusting nature is called as relative addressing. 

 
2. Absolute Addressing: If we don’t want to Excel to adjust references will we copy formula to 

different cells then we can use an absolute reference. 
  Ex: If our formula multiplies cell A5 with cell C1 (=A5*C1) and you copy the formula to 

another cell, Excel will adjust both reference. You can create an absolute reference to cell C1 
by placing a dollar sign ($) before the parts of the reference that do not change. To create an 
absolute reference to cell C1, Ex: Add dollar signs ($) to the formula as follows:
 =A5*$C$1. 

 
Cell Address: It is a name of the cell, which is actually made up of a row a column number. 
 Ex: The address of the first cell in a worksheet is A1.       
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MS-Excel window is: 

 
Title bar: The top most portion of any window is called Title bar. This bar displays the file name & 
name of the application on the left hand side. On the right hand side display three buttons. They are 
as follows: 

i. Minimize button 
ii. Maximize button 

iii. Close button. 
 

i. Minimize button: Minimize button is used to reduce a window into a button.  
ii. Maximize button: Maximize button is used to enlarge a window to fill the whole screen. 

iii. Close button: Close button is used to close a window. 
 

Menu bar: Every window displays the Menu bar just below the Title bar. Menu bar contains certain 
menus such as: File, Edit, View, Insert, Format, Tool, Table, Window and Help.  
 
Standard Toolbar: Toolbar is consists of various picture buttons which are shortcuts to the 
frequently used options available on the Menu bar. It is located just below the Menu bar. 
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Formatting Toolbar: Format bar is consists of various picture buttons which are shortcuts to the 
frequently used available on the Format menu. It is located just below the standard Tool bar. 
 
Formula bar: Formula bar is shows the address of the active cell (i.e. name of the place where the 
cell point is located) and the contents of the active cell. It is located just below the Formatting 
toolbar.  
   
Vertical Scrolling bar: A rectangular bar having two buttons used to move the work area up &       
down is called Vertical Scrolling bar. 
 
Horizontal Scrolling bar: A rectangular bar having two buttons used to move the work area right & 
left is called Horizontal Scrolling bar. 
 
Status bar: Status bar displays Ready on the left hand side and NUM on the right hand side. It is 
located at the bottom of MS-Excel window. 
 
File Menu: 

The options present in File Menu are as follows: 
1. New… 
2. Open… 
3. Close 
4. Save 
5. Save As... 
6. Save as HTML 
7. Save Workspace 
8. Page Setup… 
9. Print Preview 
10. Print area 
11. Print 
12. Send To 
13. Properties 
14. Exit. 

 

1) New…: New… option is used to create a new worksheet. 
 Shortcut for New option is:  Ctrl+N.  
 
2) Open…: Open… option is used to open a created worksheet. 
 Shortcut for Open option is:  Ctrl+O.  
 
3) Close: Close option is used to close the current workbook. 
 Shortcut for Close option is: Alt+F then press C. 
 
4) Save: Save option is used to save the worksheet with new name. 
 Shortcut for Save option is:  Ctrl+S.  
 
5) Save As…: Save As… option is used to save current worksheet with other name. 
 Shortcut for Save As… option is:  Alt+F then press A.  
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6) Save as HTML: Save as HTML option is used to save the file in HTML type.  
 
7) Save Workspace: Save Workspace option is used to save the selected spaces which know as 

workspace so that we can print saved workspace. 
 Shortcut for Save Workspace option is: Alt+F then press W.  
     
8) Page Setup: Page Setup option is used to set the page margins, to select paper size type and 

to adjust page layout for printing purpose. 
Shortcut for Page Setup option is:  Alt+F then press U.  

 
9) Print Preview: Print Preview option is used to see how our worksheet will look after 

printing. Shortcut for Print Preview option is:  Alt+F then press V. 
 
10) Print Area: Print Area option is used to save the selected area which we have set. 
 Shortcut for Print Area option is: Alt+F then press T.  
 
11) Print: Print option is used to print the whole worksheet or selected items. 
 Shortcut for Print option is:  Ctrl+P.  
 
12) Send To: Send To option is used to send our workbook to different location in the world 

with the help of Internet. Shortcut for Send To option is: Alt+F then press D. 
 
13) Properties: Properties option is used to store the properties of workbook, so that we can use 

them to undo stand whole document. Shortcut for Properties option is: Alt+F then press I.  
 
14) Exit: Exit option is used to come out from the MS-EXCEL window. 
 Shortcut for Exit option is:  Alt+F then press X.  
 

Edit Menu: 
The options present in Edit Menu are as follows: 
1. Undo 
2. Redo 
3. Cut 
4. Copy 
5. Paste 
6. Paste Special… 
7. Paste as Hyperlink   
8. Fill 
9. Clear 
10. Delete 
11. Delete Sheet 
12. Move or Copy Sheet 
13. Find… 
14. Replace… 
15. Go To… 
16. Links…  
17. Object Properties 
18. Object. 
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1) Undo: Undo option is used to cancel the pervious action. 
 Shortcut for Undo option is: Ctrl+Z. 
 
2) Redo: Redo option is used to cancel the undo action/repeat the action. 
 Shortcut for Redo option is: Ctrl+Y.  
 
3) Cut: Cut option is used to cut the selected text and stores in the Clipboard. 
 Shortcut for Cut option is:   Ctrl+X.  
 
4) Copy: Copy option is used to copy the selected text and stores in the Clipboard. 
 Shortcut for Copy option is:   Ctrl+C. 
 
5) Paste: Paste option is used to insert the copy/cut text to other location. 
 Shortcut for Paste option is:   Ctrl+V. 
 
6) Paste Special: Paste Special option is used to paste the copied/cut item in a following ways:  

i. All 
ii. Formulas 

iii. Values 
iv. Format 
v. Comments 

vi. Validations 
vii. All except borders 

viii. Column width 
ix. Operation 
x. Skip blanks 

xi. Transpose 
xii. Paste links. 
Shortcut for Paste Special option is:   Alt+E then press S. 

 
i. All: All option is used to paste every thing, like: formatted text comments, validation, 

form values, etc. 
 

ii. Formulas: Formulas option is used to paste all formula as entered in the formula bar. 
 

iii. Values: Values option is used to paste only the values that the copied collection not the 
formulated text. If copied cells have validation. 

 
iv. Format: Format option is used to paste only cell format. 

 
v. Comments: Comments option is used to paste only comments that are attached to the 

cell. 
 

vi. Validation: Validation option is used to paste validation only if the copied cells have 
validation. 
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vii. All except borders: All except borders option is used to paste all contains and 
formatting applied to copied cell except its borders. 

 
viii. Column width: Column width option is used to paste e column width of the copied 

cell. i.e.: If copied cell have 10cm column width then it will copy that width. 
 

ix. Operation: Operation option is used to specify mathematically operation it any use 
want to apply to the copied data. With the content of the cell. 

 
x. Skip blanks: Skip blanks option is used to avoid replacing. 

 
xi. Transpose: Transpose option is used to paste the copied column as row and vice versa. 

i.e.: It will paste 20 as 20 10 30
 10  
 30  

 
xii. Paste links: Paste links option is used to paste as link to the copied data. 

Ex: Suppose we are copied $E$5 symbol in formula bar when it is pasted somewhere in 
the sheet.  

 
7) Paste as Hyperlink: Paste as Hyperlink option is used to paste the copied text such that 

whenever we click that the selection box will go to its original paste from where we have 
copied it. Shortcut for Paste as Hyperlink option is: Alt+E then press H.  

 
8) Fill: Fill option is used to fill data in cell according to given series. 
 Shortcut for Fill option is: Alt+E then press I. 
    
9) Clear: Clear option is used to erase the selected text in a following ways: 

i. All 
ii. Format 

iii. Contents 
iv. Comments 

Shortcut for Clear Selection option is:   Alt+E then press A. 
 

i. All: All option is used to delete every thing.  
Shortcut for All option is: Alt+E then press A & A.  

 
ii. Format: Format option is used to delete only format of the cell. 

Shortcut for Format option is: Alt+E then press A & F.  
 

iii. Contents: Contents option is used to delete the contents of the cell but not format cell. 
Shortcut for Contents option is: Del. 

 
iv. Comments: Comments option is used to delete only the comments given to the cell. 

Shortcut for All option is: Alt+E then press A & C.  
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10) Delete: Delete option is used to delete but in this we not select anything.  
 Shortcut for All option is: Alt+E then press D.  
 
11) Delete Sheet: Delete Sheet option is used to delete entire sheet permanently. 
 Shortcut for All option is: Alt+E then press L.  
 
12) Move or Copy Sheet: Move or Copy Sheet option is used to move current sheet to another 

worksheet or copy it to the other book. Shortcut for All option is: Alt+E then press M.  
 
13) Find..: Find... option is used to find the text from the current worksheet and we can also find 

formula & comments given to the sheet. Shortcut for Find... option is:   Ctrl+ F.  
 
14) Replace…: Replace option is used to replace the find text or formula or comments some 

other text or formula or comments. Shortcut for Replace option is:   Ctrl+H. 
 
15) Go To…: Go To… option is used to go to various things like: 

i. Comments 
ii. Constants 

iii. Formula 
iv. Current region 
v. Currents array 

vi. Object 
vii. Row differences 

viii. Column differences 
ix. Precedents 
x. Dependences 

xi. Last cell 
xii. Visible cell only 

xiii. Conditional formats 
xiv. Data validations. 

 Shortcut for Go To… option is: Ctrl+G 
 

i. Comments: It will select all comments.  
 

ii. Constants: Select all cells whose values do not start with an equal sign or contain a 
formula. The check boxes below this option define the type of constant you want to go 
to. 

 
iii. Formula: Select all cells that contain formula. The check boxes below this option 

define the type of formula you want to go to.   
 

iv. Current region: It will select the rectangle cell range around the active cell. 
 

v. Currents array: It will select the entire array. 
 

vi. Object: It will select all graphic objects. 
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vii. Row differences: Select cells whose contents are different from he comparison cell in 
each row. For each row, the comparison cell is in the same column as the active cell. 

 
viii. Column differences: Select cells whose contents are different from the            

comparison cell in each column. For each column, the comparison cell is in the same 
row as the active cell. 

 
ix. Precedents: It will select the cells which are being. Used to calculate formula. 

 
x. Dependences: It will select the cells which contains formula. It means that formula 

depends upon other element. 
 

xi. Last cell: It will go to the last cell of the sheet which contain data or formulated cell. 
 

xii. Visible cell only: It will go or select the cell which are visible but not the hidden row or 
column. 

 
xiii. Conditional formats: It will select only the cell which we have given conditional 

formats. 
 

xiv. Data validations: It will select the cell which validations applied. 
a. All 
b. Same. 

 

a. All: All option is used to select all the cells in the worksheet that have data 
validation. 

 

b. Same: Same option is used to select the cells which have same type of validation as 
the currently selected cells.  

 
16) Links…: Links… option is used to create links to our file with some other file so that we can 

edit the linked objects. Shortcut for Links… option is: Alt+E then press K.   
 
17) Object Properties: Object Properties option is used to set the different properties to object 

such as changing icons, we can also create or insert objects from file. 
 Shortcut for Object Properties option is: Alt+E then press R.  
 
18) Object: Object option is used to insert objects. 
 Shortcut for Object option is: Alt+E then press O. 

 
View Menu: 

The options present in View Menu are as follows: 
1. Normal 
2. Page Break Preview 
3. Tools bar 
4. Status bar 
5. Formula bar 



Chapter4.2: MS-EXCEL                                                                        
 

WRITTEN BY SAMEER YOU CAN CONTACT ME AT KILLERKHAN007@REDIFFMAIL.COM 

6. Head and Footer 
7. Comments 
8. Custom View 
9. Full Screen 
10. Zoom. 

 
1) Normal: Normal option is used to show our data in normal view where we edit data. 
 Shortcut for Normal option is:  Alt+V then press N. 
  
2) Page Break Preview: Page Break Preview option is used to show our data in page break 

preview and also show multi pages as a single page.  
 Shortcut for Page Break Preview option is: Alt+V then press P. 
  
3) Tools bars: Tools bars option is used to add or remove toolbars. 
 Shortcut for Tools bars option is: Alt+V then press T. 
  
4) Status bar: Status bar option is used to show/hide status bar in Excel window. 
 Shortcut for Status bar option is: Alt+V then press S. 
  
5) Formula bar: Formula bar option is used to show/hide formula bar in Excel window. 
 Shortcut for Formula bar option is: Alt+V then press F. 
  
6) Head and Footer: Head and Footer option is used to give some heading or footnote so that 

page will contain the some heading. 
Shortcut for Head and Footer option is: Alt+V then press H. 

  
7) Comments: Comments option is used to display all comments made by all reviewers in the 

comment pane. In MS-Excel, turns display of comments on the worksheet on or off. 
 Shortcut for Comments option is: Alt+V then press C.  
 
8) Custom View: Custom View option is used to create different views of the worksheet. A 

view provides an easy way to see your data with different display options. We can display 
print and store different views without saving them as separate sheets. 

 Shortcut for Custom View option is: Alt+V then press V. 
  
9) Full Screen: Full Screen option is used to hide most screen elements so that we can view 

more of current document. To switch back your previous view click full screen or press Esc 
key. Shortcut for Full Screen option is: Alt+V then press U.  

 
10) Zoom: Zoom option is used to enter a magnification between 10 and 400 percent to reduce 

or enlarge the display of the active worksheet. 
Shortcut for Zoom option is: Alt+V then press Z. 
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Insert Menu:  
The options present in Insert Menu are as follows: 
1. Cells 
2. Insert Columns 
3. Worksheet 
4. Chart Wizard 
5. Paste Function 
6. Page Break 
7. Comments 
8. Name 
9. Picture 
10. Object 
11. Hyperlink. 

 
1) Cells: Cells option is used to insert cells starting at the insertion point. We can choose to shift 

other cells in the table option is used to the right or down. We can also insert an entire row or 
column. Shortcut for Cells option is: Alt+I then press E. 

  
2) Insert Columns: Insert Columns option is used to insert the number of cells, rows, columns. 

In Word, this option is available only when you have selected one or more end of cell marks. 
 Shortcut for Insert Columns option is: Alt+I then press C.  
 
3) Worksheet: Worksheet option is used to insert a new worksheet to the left of selected sheet. 
 Shortcut for Worksheet option is: Alt+I then press W. 
  
4) Chart Wizard: Chart Wizard option is used to start the chart wizard which guides you 

through the step for creating an embedded chart on a worksheet or modifying an existing 
chart. Shortcut for Chart Wizard option is: Alt+I then press H. 

  
5) Paste Function: Paste Function option is used to display a list of function and their formats 

and allow you to set values for arguments. 
Shortcut for Paste Function option is: Alt+I then press F. 

 
6) Page Break: Page Break option is used to insert a page break above a selected cell. This 

option change to remove page break. If you have a cell selected that is adjacent to a manually 
inserted page break. Shortcut for Page Break option is: Alt+I then press B. 

  
7) Comments: Comments option is used to insert a comment at the insertion point. 
 Shortcut for Comments option is: Alt+I then press M. 
  
8) Name: The options present in Name option are as follows: 

i. Define 
ii. Create 

iii. Label 
iv. Paste 
v. Apply  
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i. Define: Define option is used to create a name for a cell, range, or constant or 
computed value that you can use to refer to the cell, range, or value. 

 Shortcut for Define option is: Alt+I then press N & D. 
  

ii. Create: Create option is used to create names by using label in a selected range. 
 Shortcut for Create option is: Alt+I then press N & C. 
 

iii. Label: Label option is used to predefined label ranges so that MS-Excel can 
automatically apply text labels to your formulas. 

 Shortcut for Label option is: Alt+I then press N & L. 
 

iv. Paste: Paste option is used to paste the selected name into the formula bar. If the 
formula bar is active and you begin a formula by typing an equal (=) sign, clicking 
Paste pastes the selected name at the insertion point. If the formula bar is not active, 
double clicking a name in the Paste Name box pastes an equal (=) sign followed by the 
selected name into the formula bar. Shortcut for Paste option is: Alt+I then press N 
& P. 

 
v. Apply: Apply option is used to searches formula in selected cells and replace 

references with names defined for them, if they exist.  
 Shortcut for Apply option is: Alt+I then press N & A. 

 
9) Picture: Picture option is used to insert various things in our worksheet, so that made good 

look of sheet. With the help of this option we can insert Clip art, any drawing from file, Auto 
shapes, Organization charts and Word Art etc. 
Shortcut for Picture option is: Alt+I then press P. 

 
10) Object: Object option is used to insert object into our worksheet, so that we can perform or 

do in other packages. Shortcut for Object option is: Alt+I then press O. 
 
11) Hyperlink: Hyperlink option is used to link the current worksheet with other 

worksheet/workbook, so that whenever we click that we can go to the linked sheet or 
worksheet. Shortcut for picture option is: Ctrl+K. 

 
Format Menu: 

The options present in Format Menu are as follows: 
1. Cells 
2. Row 
3. Column 
4. Sheet 
5. AutoFormat 
6. Conditional Formatting 
7. Style. 
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1) Cells: Cells option is used to give special effects to a cell or selected range of cell. With the 
help of this option we can increase the size, angle of the cell and can also be given borders 
and background to that cell. Shortcut for Cells option is: Ctrl+1. 

  
2) Row: Row option is used to format a single row or a group of rows. With the help of this 

option we can increase or decrease the height of technology row. We can make it as AutoFit; 
we can also hide or unhide the row. Shortcut for Row option is: Alt+O then press R. 

 
3) Column: Column option is used to same as he row but the difference is that we can format to 

a column or groups of column. Shortcut for Column option is: Alt+O then press C. 
 
4) Sheet: Sheet option is used to rename the particular sheet; we can hide or unhide the sheet in 

which we are working. We can also give background to the sheet.  
 Shortcut for Sheet option is: Alt+O then press H. 
 
5) AutoFormat: AutoFormat option is used to automatic formats the selected cells, so that we 

need not have to do anything. Shortcut for AutoFormat option is: Alt+O then press A. 
 
6) Conditional Formatting: Conditional Formatting option is used to applies the formats to 

selected cells, such that it uses the given condition to format. 
 Shortcut for Conditional Formatting option is: Alt+O then press D. 
 
7) Style: Style option is used to apply format to the selection of the combination, which is 

known as style. Shortcut for Style option is: Alt+O then press S. 
 

Tools Menu: 
The options present in Tools Menu are as follows: 
1. Spelling 
2. Auto Correct 
3. Share Workbook 
4. Track Changes 
5. Marge Workbook 
6. Protection 
7. Online Collaboration 
8. Goal Seek 
9. Scenarios 
10. Auditing 
11. Macro 
12. Add-Ins 
13. Customize 
14. Options 

 
1) Spelling: Spelling option is used to check spelling in the current workbook. If there is any 

spelling mistake we can clear using this option. Shortcut for Spelling option is: F7. 
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2) Auto Correct: Auto Correct option is used to set the options which will correct the text 
automatically as we type. If we set the text, we can use later frequently. 

 Shortcut for Auto Correct option is: Alt+T then press A.  
 
3) Share Workbook: Share Workbook option is used to open the shared workbook mode. So 

that we can use or other users can also use the same workbook. 
 Shortcut for Share Workbook option is: Alt+T then press R. 
 
4) Track Changes: Track Changes option is used to find out the changes we have done in 

worksheet. Shortcut for Track Changes option is: Alt+T then press T. 
 

i. Highlight Changes: Highlight Changes option is used to modify or delete or insert any 
type of matter. It will highlights changes to cell contents in a shared workbook. 
Shortcut for Highlight Changes option is: Alt+T then press H. 

 
ii. Accept Changes or Reject Changes: Accept Changes or Reject Changes option is 

used to accept or reject each change which we have done in worksheet. 
Shortcut for Accept Changes or Reject Changes option is: Alt+T then press A. 

 
5) Marge Workbook: Marge Workbook option is used to combines changes from multiple 

copies of a shared workbook into one workbook. i.e.: It combines the changes from other 
workbook into our workbook. Shortcut for Merge Workbook option is: Alt+T then press W. 

 
6) Protection: Protection option is used to protect our workbook; there are various options 

available by which we can protect individual sheets, workbook or shared workbooks. 
 Shortcut for Protection option is: Alt+T then press P. 
 
7) Online Collaboration: Online Collaboration option is used to help us to work present file on 

Internet. That we can share that workbook on Net also. 
 Shortcut for Online Collaboration option is: Alt+T then press N. 
 
8) Goal Seek: Goal Seek option is used to change the value of one cell by changing the value of 

other cell. i.e.: It will adjust the value in a cell when we change the value of targeted cell.    
 Shortcut for Goal Seek option is: Alt+T then press G. 
 
9) Scenarios: Scenarios option is used to create and saves Scenarios so that, it changes the 

value of the cell, where the formula is stored, without changing the value of any other cell.   
 Shortcut for Scenarios option is: Alt+T then press E. 
 
10) Auditing: Auditing option is used to give or show the relation of one cell to the other cell. 

i.e.: It can show arrow marks so that we can see where the relation of one cell.  
 Shortcut for Auditing option is: Alt+T then press U. 
 
11) Macro: Macro option is used to record the actions when we switch on the “Record New 

Macro” option so that whenever we run it, it paste it the recorded actions.  
 Shortcut for Macro option is: Alt+T then press M. 
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12) Add-Ins: Add-Ins option is used to specify which add-ins is automatically available when 
we start MS-Excel. We can also load or unload add-ins that comes with MS-Excel as well as 
add-ins programs that we create. Shortcut for Add-Ins option is: Alt+T then press I. 

 
13) Customize: Customize option is used to add or remove menu or toolbars or options that are 

available in that toolbars. It is same as the customize option of word. 
 Shortcut for Customize option is: Alt+T then press C. 
 
14) Options: Options option is used to set On/Off of the MS-Excel programs such as: 

Appearance, Printing, Editing etc. options.  
Shortcut for Options option is: Alt+T then press O. 

 
Data Menu: 

The options present in Data Menu are as follows: 
1. Sort 
2. Filter 
3. Advance Filter 
4. Subtotal 
5. Validation 
6. Form 
7. Table 
8. Text-to-Column 
9. Consolidate 
10. Group and outlines 
11. Auto Outline 
12. Pivot Table and Pivot Chart Report. 

 
1) Sort: Sort option is used to arrange the information of the selected rows or list in 

alphabetically, numerically in date wise order.  
Shortcut for Sort option is: Alt+D then press S. 

  
2) Filter: Filter option is used to quickest way to select only those items that we want to display 

in a list. i.e.: It will automatically put he filter symbol. 
 Shortcut for Filter option is: Alt+D then press F. 
 
3) Advance Filter: Advance Filter option is used to filter the data in a list so, that only the rows 

which have some condition we specify by using a criteria range are displayed. 
 Shortcut for Advance Filter option is: Alt+D then press A. 
 
4) Subtotal: Subtotal option is used to calculate subtotal and grand total values for the labeled 

columns that we select. MS-Excel automatically inserts and labels the total rows and outlines 
the lists. Shortcut for Subtotal option is: Alt+D then press B. 

 
5) Validation: Validation option is used to give restriction to users to insert data of particular 

type such as whole numbers, decimal numbers or text. 
 Shortcut for Validation option is: Alt+D then press L. 
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6) Form: Form option is used to displays a data form in a dialog box we can use the data form 
option is used to see, change, add, delete and find he records in a list or database. 

 Shortcut for Form option is: Alt+D then press O. 
 
7) Table: Table option is used to create a data table which are based on input values and 

formulas that we define. Data tables can be used to show the results of changing values in our 
formulas. Shortcut for Table option is: Alt+D then press T. 

 
8) Text-to-Column: Text-to-Column option is used to convert the selected text to able form. 
 Shortcut for Text-to-Column option is: Alt+D then press E. 
 
9) Consolidate: Consolidate option is used to combine corresponding values from different 

sheets into a common sheet.   
OR It summarizes he data from one or more source areas and displays it in a table. 
Shortcut for Sort option is: Alt+D then press N. 

 
10) Group and Outlines: Group and Outlines option is used to define the selected rows/columns 

of detail data as a group in an outlines that we can summarizes the data. If we have not 
created an outline, this option creates one for us. Data PivotTable or PivotChart report, this 
option group’s item in a field to create a single item from multiple item. Ex: You can group a 
days, weeks, months or other dates into quarters.  

 Shortcut for Group and Outlines option is: Alt+D then press G. 
 
11) Auto Outline: Auto Outline option is used to automatically outline a selected range of cells 

or the entire worksheets, on formulas and the direction of references. 
 Shortcut for Auto Outline option is: Alt+D then press A. 
 
12) Pivot Table and Pivot Chart Report: Pivot Table and Pivot Chart Report option is used to 

start the Pivot Table and Pivot Chart wizard, which guides through creating or modifying a 
Pivot Table or Pivot Chart Report. 
Shortcut for Pivot Table and Pivot Chart Report option is: Alt+D then press P. 

 
Window Menu: 

The options present in Window Menu are as follows: 
1. New Window 
2. Arrange 
3. Hide 
4. Unhide 
5. Split 
6. Freeze Panes. 
 
1) New Window: New Window option is used to open a new window with the same contents as 

the active window so that we can view different parts of a file at the same time.  
 Shortcut for New Window option is:  Alt+W then press N.  
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2) Arrange: Arrange option is used to display all open files in separate window on the screen. 
The arrange option makes its easier to drag between files.  

 Shortcut for Arrange option is: Alt+W then press A. 
 
3) Hide: Hide option is used to hide he active workbook window. A hidden window remains 

open. Shortcut for Hide option is: Alt+W then press H. 
 
4) Unhide: Unhide option is used to displays hidden workbook windows. Where we can unhide 

the workbook which we had hide. Shortcut for Unhide option is: Alt+W then press U. 
 
5) Split: Split option is used to split the active window into panes or removes the split from the 

active window. Shortcut for Split option is: Alt+W then press S. 
 
6) Freeze Panes: Freeze Panes option is used to freeze the top pane, the left pane or both on the 

active worksheet. Use the Freeze Panes button to keep column or row titles in view while 
you are scrolling through a worksheet. A freeze title on a worksheet does not affect printing.  

 Shortcut for Freeze Panes option is:  Alt+W then press F. 
 
Help Menu: 

The options present in Help Menu are as follows: 
1. Microsoft Excel Help 
2. Show the Office Assistance 
3. What’s this? and 
4. About Microsoft Excel. 

 
1) Microsoft Excel Help: Microsoft Excel Help option is used to provide help topics and tips 

of the MS-Excel. Shortcut for About Microsoft Excel option is: F1. 
 
2) Show the Office Assistance: Show the Office Assistance option is used to show or remove 

the office assistance from view. 
 Shortcut for Show the Office Assistance option is: Alt+H then press O.   

 
3) What’s This?: What’s This? option is used to specify a topic, choose a option or click an 

object. Shortcut for What’s This? option is: Shift+F1.   
 
4) About Microsoft Excel: About Microsoft Excel option is used to display the version number 

of this Microsoft program, copyright, information about operating system, etc.   
 Shortcut for About Microsoft Excel option is: Alt+H then press A.   

 


